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This guide explains what i-Access Library is, how you can use it to search the online library catalogue, and the various ways you can save, read, and download library content.
The online version of this guide, and instructions on how to use i-Access Library with JAWS screen reading software, are available at the i-Access Library Home page (login required).
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i-Access Library is available for Vision Australia Library members only. You can find it at www.visionaustralia.org/library/login
If you can’t remember your login details, select the Forgot password or Email link and follow the prompts. 
Logging out of My Vision Australia can be done at any time by selecting Edit Account and Log out.
[bookmark: _Toc177635969]Layout
The i-Access Library Home tab is divided into eight main sections accessed through the menu on the left-hand side of the page:
· HOME – Access to quick resources to get you started
· SEARCH - Search for content including the ability to do an advanced search.
· MY LIBRARY – Where you can access:
· My Bookshelf - "what you're reading now"
· Request List - "what you've requested or saved to read later"
· Subscriptions - "all periodical subscriptions"
· MY HISTORY - View all books / music braille previously loaned
· MY PREFERENCES - Select from a range of options to help make searching and receiving Library content easier
· CONTACT LIBRARY – Contact details and operating hours for Vision Australia library service.
· LIBRARY TERMS AND CONDITIONS – Link to the most recent terms and conditions of the Vision Australia library service.
Each of these will be discussed in more detail in the following sections of this user guide.
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The Vision Australia Library Connect App allows you to read your online library materials using your smart phone, iPad/tablet, or compatible device on the go. It is free, easy to download and use.
You can either read your material straight away (stream it with Wi-Fi) or download it to your device (with Wi-Fi). Please note: If a title has been downloaded you can listen to it offline. You do not need to be connected to Wi-Fi. 
You can quickly and easily search the online catalogue, find what you want, and add it to your bookshelf.
To download the App, search for Vision Australia Connect on the Apple Store or Google Play store.
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The Envoy Connect is a portable and simple to use audio player available from the Vision Australia store.
The Envoy Connect player comes with a Windows software utility called I-access Kiosk. If you or someone you know is a computer user, this utility can simplify downloading of books from the online catalogue and automatically load them onto the player for you correctly.
The i-access Kiosk software can be found in the System folder on the player.
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You can use your electronic or refreshable Braille display device to access downloaded Braille content on Vision Australia's online catalogue.
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Library members can use other compatible devices to read their library materials including: their own computer, smart phone, iPad/tablet, or handheld DAISY player like the Victor Reader Stream.
You can use the i-Access Kiosk software for Windows on your computer (in local computer mode) to read library content on compatible devices.
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Search is available from the library home page, which is the default starting page each time you log into your My Vision Australia account.
On this page you can search the library catalogue by entering the words you want to search for into the Keyword Search box and pressing the Enter key or activating the Search button.
You can search for a particular collection type using the Type dropdown list. This is located below the Keyword box. The default Type for searching is Books.
You can also select the format you would like to receive books in, such as All formats, Braille, DAISY audio (Human). The Format dropdown list if located below the Type option
TIP 1: If you cannot find what you are searching for in the catalogue, first check that you have spelled it correctly. Then try broadening your search by typing only one or two keywords that you know are in the title. If it your title still cannot be found, it is possible that the title is not in our Library collection. In this case, please contact the library.
TIP 2: If your search produces too many results, and you want to narrow it down, try using the Advanced Search. This is available as a link above the Search button.
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You can Browse for some types of library resources but not all. 
Browsing without a keyword for Books and either All Formats or Daisy Audio format will not work, because of the number of possible search results. 
You can browse without entering a keyword for all other Type and Format combinations. 
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For more complex searches you can use the Advanced Search page. This will display additional search options and allow you to restrict your search to keywords, title, name (author or narrator), type, format, or language.
You can also select a category you are interested in, using the Category dropdown list. This will then show the matching sub-categories that you can select. All sub-categories are unticked by default, you need to tick the ones you are interested in.
You can also choose the Format you want to search for. Formats available to choose from are All formats, Braille, eBraille, Daisy Full Text (Audio), Daisy Audio (Human), or Daisy Audio (Synthetic).
Choose the search options you want and select the Search button at the bottom of the screen. 
There is a Clear All button at the bottom screen above the Cancel button, if you want to clear your selections and start again.
There is also a Cancel option at the bottom of the screen, above the Search button. This will close the Advanced Search and return you to the standard Search screen.
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Use the Advanced Search option to find titles in a language other than English (LOTE). There are twenty-one languages to choose from.
To find titles in a particular language click on the Advanced Search link. 
Use the Language dropdown list to limit the search to the language you want. You can then select the Search button.
The results returned will be in the chosen language. These can then be added to the Bookshelf or Request List.
Another way to find books in a language other than English is to use the Advanced Search categories. Select LOTE as the category and your preferred language as the sub-category. You can then browse through the library materials held in that language.
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Search results will be displayed with the heading “Showing [x number] results for [your search term]”.
Ten results are displayed on each page with the ability to increase to twenty. 
At the bottom of the search results page, there are Next and Previous links and page numbers that you can use to move between the pages of the search results.
TIP for screen readers: When you land on the “Pagination” heading, you are at the end of the list of library items on the Search page, and above the page links.
Search results will be displayed with a separate entry for each format (if the item has more than one format).
Some basic information is displayed for each item in the list. More details about the item can be viewed by selecting the Title link which will open the Item Details page. You can go back to your search results by clicking on the Return to previous page link, located under the Format.
Search results are sorted by Most Relevant. This means they will be ordered based on the closest match to your keywords, with matches found in the title listed first. 
You can sort your search results using the Sort dropdown box to display:
· Newest on top: the most recent books added to the collection
· Oldest on top: the oldest books added to the collection
· Author: A-Z by surname
· Title: A-Z by title.
Each search result has an option to "Add to Bookshelf", "Add Request" or "Subscribe" depending on its format or type.
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Within Vision Australia’s Library catalogue, you must add an item to your Bookshelf to download it. 
Please note: There is a limit of 20 books and music braille titles that a library member can have on loan at any given time. 
To add an item to your Bookshelf, find the search result in the Format you prefer such as DAISY audio (human) or eBraille (downloadable). Use the Add to Bookshelf option located below each item on the Search results page. This will add the item to your Bookshelf. 
Each time an item is added to your Bookshelf a message will appear to say how many books you now have on your Bookshelf and how much space you have left for more books. You can select Close to go back to the search results page or Go to my Bookshelf which will take you to your Bookshelf. 
Go to the My Bookshelf section for information on how to manage your Bookshelf.
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When an embossed Braille item is selected in the search results, choose Add Request.
If you would like an embossed Braille copy of this title posted to you, please click "Proceed" to forward the request to the library for processing. A copy will be sent to you when one is available.
If you don’t want to proceed, click "Cancel" to go back.
[bookmark: _Toc177635982]Adding Titles to your Request List
The request list allows you to maintain a reading list for later use. 
To add an item onto your request list, find the book or music braille item in the search results. Select the Add Request button located to the right of the Add to Bookshelf button at the bottom of each search result listing, or from the Item Details page. The title will now appear on your Request List.
A message box will appear advising the book title has been added to your Request List. Select Go to Request List to access your list of requested books, or
Close to return to the search results page.
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Newspapers, Magazines, and Podcasts are available for you to subscribe to. 
To subscribe to an item, select the type of item you want from the Type dropdown list (such as Newspapers). 
In the search results, find the format you want (DAISY Audio (synthetic), DAISY Text, DAISY Audio (human) or eBraille) and select the Subscribe button. 
A message box will appear confirming the periodical has been added to your subscription list. You can select Go to Subscriptions to go to your list of subscriptions or, Close to return to the search results screen.
After subscribing, new issues will automatically be added to your Bookshelf each time they become available.
There are no restrictions to the number of periodicals you can have on loan or subscribe to at any given time, however you can only have a maximum of 3 issues per periodical on your Bookshelf. Adding a new issue once reaching this number will replace the oldest issue for that periodical on your Bookshelf.  
You can select back issues to add to your Bookshelf by selecting the View All Issues button and choosing the issues you wish to add to your Bookshelf. Before selecting the back issues, check that you are viewing the Title record with your preferred Format.
You can add up to three back issues to your Bookshelf.
Go to the Subscriptions section for information on managing your subscriptions

[bookmark: _Toc177635984]My Library
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The My Bookshelf page shows your current reading list.
The Bookshelf is separated into two sections: Books and Music Braille, and Periodicals.
In the rare event a title has failed being added onto your Bookshelf, the status will show ‘packaging failed’. In this event, please select an alternative title or contact the library for further support. 
To download the title, you will need to go to the Bookshelf and locate the item. Start the download by selecting the download Button to the right of the title. 
All items are downloaded as zipped files and delivered in the file format you selected when adding the item on your Bookshelf. 
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Downloading an item does not remove it from your Bookshelf.
To remove an individual item from your Bookshelf, tick the box to the left of the title and select the Remove Selected button link located under Manage List at the top of the list of titles.
You can also remove multiple books by ticking multiple boxes, or all books at the same time by ticking the Select All box under Manage List and then selecting the Remove Selected button.
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Please note: This only applies to members who are manually downloading these files to their computer.
It DOES NOT apply to any member using the App or a DAISY player. If you are using any of these to read content from the library, the files will unzip automatically and be ready to read.
A Zip file is a single file that contains all the files that belong to the same title.  Most DAISY players or other readers require you to unzip the files before you can read them. When ‘unzipping’ a Zip file you are prompted to choose where to save the extracted files so that you can access them. You can easily unzip by using the Extract All feature in Windows File Explorer. You can also use a program like WinZip.
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The Request List page shows the items you've saved to read later.
To download these items (or listen to them on your device) they need to be added onto your Bookshelf. This can be achieved in two different ways.
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Find the item you want to read next and select the Add now button.
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· Self-Managed users: o have your items automatically moved from your Request List to the Bookshelf when space becomes available, in the Auto Allocation Settings page ensure Request allocation is ON and a number has been selected in the Maximum titles auto-sent box under Number of titles. 
· Auto-Allocation users: Items automatically move from your Request List to the Bookshelf when space becomes available.
To remove items from your Request List, select the Remove item link located next to each title.
You need to have space on your Bookshelf to add an item from your Request List. If you have 20 books and music braille on your Bookshelf, select the Remove item link on items you no longer need to make space. 
To set titles to be automatically pushed to your Bookshelf, or to adjust how you’d like to receive library content, go to the My Preferences section for more information.
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This section displays all the periodicals, such as newspapers and magazines, you have indicated you would like to receive on a regular basis. Once you have subscribed to a periodical, the latest issues will automatically appear in your Bookshelf as they become available.
There are no restrictions to the number of periodicals you can have on loan or subscribe to at any given time, however you can only have a maximum of 3 issues per periodical on your Bookshelf. 
Once you reach the maximum number of three issues for a periodical, adding a new issue will result in the oldest issue being replaced by the newest issue.
You can remove an item from your Subscriptions list by selecting the Unsubscribe link located next to the item in the list.
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My History shows all books and music braille previously loaned. 
Results are presented in date order, newest to oldest. You can sort by either Title (A-Z or Z-A) or Date loaned (newest to oldest or oldest to newest) by selecting the up/down arrows. 
My History doesn't include periodical issues.
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Members who prefer to have Library books automatically chosen for them must have Auto allocation settings set up. In this section you can set your reading preferences used to find titles you're interested in.
Profile allocation must be ON.
Request allocation must be ON.
Number of titles (from 1-20) must be chosen and saved.
The Profile Allocation section is broken up into three sections.
· Categories: where you can include or exclude to receive books from, based on your interests.
· Explicit content: where you can select to exclude sexual and violent content, and content with coarse language.
· Narrator and Reading level: where you can change your reading level and set the narrator gender you wish to listen to, if required.
Once your Auto Allocation preferences have been set, the Online catalogue will find content that suits your preferences and automatically push this content to your Bookshelf and device if in use until the maximum limit is reached (twenty).
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If you wish to add or exclude an author in your preferences, please contact the library. A maximum of 50 authors can be included and 50 authors excluded.
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